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• Click OK to display a blank Pivot table and filed list (Figure
2.58(c) and Excel displays the Pivot Table Toolbar

1. Drag the Field Names (From
location number 1) to the
require positions in the pivot
table (location Number 6).

2. Report Filter “Day”

3. Column Label “Vegetable”

4. Row Label “City”

5. Values “Sum of Actual” and
the final result will be
displayed (Figure 2.58(d).

6. In the above selections at Row
Label we give “City” and then
“Vegetable”; while in column
Label if we do not enter any
selection. The Pivot Report will
be as shown in Figure 2.58(e).

The Pivot Table tool bar (Figure 2.58(f) provides various flexibility to
work on data.

Figure 2.58(c)

Figure 2.58(d) Figure 2.58(e)

Figure 2.58(f) : Pivot Table Toolbar
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Advantages of Pivot Table (Report)

A PivotTable report is an interactive way to quickly summarise large
amounts of data. Use a PivotTable report to analyse numerical data in
depth and to answer unanticipated questions about data. A PivotTable
report designed for:

 Querying large amounts of data in user-friendly ways. Sub totaling
and aggregating numeric data, summarising data by categories and
subcategories, and creating custom calculations and formulas.

 Expanding and collapsing levels of data to focus on results, and
providing from details to the summary of data for areas of interest.

 Moving rows to column or columns to rows (or “pivoting”) to see
different summaries of the source data.

 Filtering, sorting, grouping, and conditionally formatting the most
useful and the interesting subset of data to enable us to focus on
the information that we want.

 Presenting concise, attractive, and annotated online or printed
reports.

 The use of a PivotTable report is to analyse related totals, when we
have a long list of figures to sum and to compare several facts
about each figure.

2.6. COMMON ERRORS (MESSAGES) IN SPREADSHEET

4.1.1  MARK COMMON FORMULA ERRORS

1. Click the Microsoft Office Button, click Excel Options, and then
click the Formulas category.

2. In the Error Checking section, select the Enable background error
checking check box.

3. To change the colour of the triangle that marks where an error
occurs, in the Indicate errors using the colour box, select a new
colour.

4. Select a cell with a triangle in the top-left corner of a cell.

5. Next to the cell, click the Error Checking button that appears, and
then click the option that we want. The commands are different for
each type of error, and the first entry describes the error. If we click
Ignore Error, the error is marked to be ignored for each consecutive
check.

6. Repeat the two previous steps.

• Correct an error value

If a formula cannot properly evaluate a result, e Excel will display an error
value. Each error type has different causes, and different solutions. Some
are discussed here to understand them properly before redo the operation

Figure 2.59
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• Correct a ##### error

This error occur when a column is not wide enough, or a negative date
or time is used.

Reason: The column is not wide enough to display the content

1. Select the column by clicking the column header.

2. On the Home tab, in the Cells group, click Format, and then
click AutoFit Column Width. Alternatively also we can double-
click the boundary to the right of the column heading.

3. Select the column.

4. On the Home tab, in the Cells group, click Format, click Format
Cells, and then click the Alignment tab.

5. Select the Shrink to fit check box.

Apply a different number format

In some cases, we can change the cell’s number format to
make the number fit within the existing cell width. For
example, we can decrease the number of decimal places
after the decimal point.

•  Correct a #DIV/0! Error

This error occurs when a number is divided by zero (0).

1. Optionally, click the cell that displays the error, click the button
that appears, and then click Show Calculation Steps if it is appears.

Reasons

a. Entering a formula that contains explicit division by zero (0) —
for example, =5/0.

Dates and times are negative numbersDates and times are negative numbersDates and times are negative numbersDates and times are negative numbersDates and times are negative numbers

When a date or time is typed in a cell, it appears in a default date and time format.
The default date and time format is based on the Regional date and time settings that
are specified in Windows Control Panel, and changes when changes are made to
those settings. We can display numbers in several other dates and time formats, most
of which are not affected by Control Panel settings.

 If we are using the 1900 date system, dates and times in Excel must be positive
values.

 When we subtract dates and times, make sure that we build the formula correctly.

 If the formula is correct but the result is still a negative value, we can display the
value by formatting the cell with a format that is not a date or time format.

1. On the HomeHomeHomeHomeHome tab, in the CellsCellsCellsCellsCells group, click ForForForForFormatmatmatmatmat, click ForForForForFormat Cellsmat Cellsmat Cellsmat Cellsmat Cells, and
then click the NumberNumberNumberNumberNumber tab.

2. Select a format that is not a date or time format.

Figure 2.60
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b. Using the cell reference to a blank cell or to a cell that contains
zero as a divisor.

Solutions

 Change the cell reference to another cell.

 Enter a value other than zero in the cell used as a divisor.

 Enter the value #N/A into the cell referenced as the divisor,
which changes the result of the formula to #N/A from #DIV/0!
To denote that the divisor value is not available.

 Prevent the error value from displaying by using the IF worksheet
function. For example, if the formula that creates the error is
=A5/B5, use =IF (B5=0,””, A5/B5) instead. The two quotation
marks represent an empty text string.

•   Correct a #N/A error

This error occurs when a value is not available to a function or formula.

1. Optionally, click the cell that displays the error, click the button

that appears, and then click Show Calculation Steps if it appears.

Reasons and Solutions

a. Missing data, and #N/A or NA() has been entered in its place.

b. Giving an inappropriate value for lookup function as an argument
such functions may be HLOOKUP, VLOOKUP, MATCH or LOOKUP.

c. Using these lookup functions to locate the value in an unsorted
table.

d. Using an argument in the array formula that is not in the same
number of rows or columns as the range that contains the array
formula.

•   Correct a #NAME? Error

This error occurs when Excel doesn’t recognize text in a formula.

Reasons:

a. The EUROCONVERT function without the Euro Currency Tools
add-in being loaded.

Solutions
1. Click the Microsoft Office Button , click Excel Options, and

then click the Add-ins category.

2. Select Excel Add-ins in the Manage list box, and then click Go.

3. In the Add-Ins available list, select the Euro Currency Tools
check box, and then click OK.

•   Correct #NULL! Error

This error occurs when we specify an intersection of two areas that do
not intersect. The intersection operator is a space between references.
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1. Optionally, click the cell that displays the error, click the button
that appears, and then click Show Calculation Steps if it appears.

2. Possible causes and solutions.

Incorrect range operator

 To refer to a contiguous range of cells, use a colon (:) to separate
the reference to the first cell in the range from the reference to
the last cell in the range. For example, SUM (A1:A10) refers to
the range from cell A1 to cell A10 inclusive.

 To refer to two areas that don’t intersect, use the union operator,
the comma (,). For example, if the formula sums two ranges
make sure that a comma separates the two ranges (SUM (A1:A10,
C1:C10)).

Ranges do not intersect

 If there are no squares at each corner of the colour-coded border,
then the reference is to a named range.

 If there are squares at each corner of the colour-coded border,
then the reference is not to a named range.

5. Double-click the cell that contains the formula we want to change.
Excel highlights each cell or range of cells with a different colour.

6. Do one of the following:

 To move a cell or range reference to a different cell or range,
drag the colour-coded border of the cell or range to the new cell
or range.

 To include more or fewer cells in a reference, drag a corner of
the border.

 In the formula, select the reference, and type a new one.

7. Press ENTER.

8. Do one of the following:

 Select the range of cells that contains formulas in which we
want to replace references with names.

 Select a single cell to change the references to names in all
formulas on the worksheet.

9. On the Formulas tab, in the Defined Names group, click the
arrow next to Define Name, and then click Apply Names.

10.In the Apply Names box, click one or more names.

•   Correct#NUM! Error

This error occurs with invalid numeric values in a formula or function.

1. Optionally, click the cell that displays the error, click the button
that appears, and then click Show Calculation Steps if it appears.

2. Review the following possible causes and solutions:
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 Using an unacceptable argument in a function that requires a
numeric argument.

 Make sure that the arguments (argument: The values that a
function uses to perform operations or calculations. The type of
argument a function uses is specific to the function. Common
arguments that are used within functions include numbers, text,
cell references, and names.) used in the function are numbers.
For example, even if the value we want to enter is $1,000, enter
1000 in the formula.

 Using a worksheet function that iterates, such as IRR or RATE,
and the function cannot find a result.

 Use a different starting value for the worksheet function.

 Change the number of times Microsoft Office Excel iterates
formulas.

1. Click the Microsoft Office Button , click Excel Options, and

then click the Formulas category.

2. In the Calculation options section, select the Enable iterative
calculations check box.

3. To set the maximum number of times that Excel will recalculate,
type the number of iterations in the Maximum Iterations box.
The higher the number of iterations, the more time that Excel
needs to calculate a worksheet.

4. To set the maximum amount of change that we will accept between
calculation results, type the amount in the Maximum Change
box. The smaller the number, the more accurate the result and
the more time that Excel needs to calculate a worksheet. Entering
a formula that produces a number that is too large or too small
to be represented in Excel.

•   Correct a #REF! Error

This error occurs when a cell reference (cell reference: The set of
coordinates that a cell occupies on a worksheet. For example, the
reference of the cell that appears at the intersection of column B and
row 3 is B3.) is not valid.

1. Optionally, click the cell that displays the error, click the button
that appears, and then click Show Calculation Steps if it appears.

2. Review the following possible causes and solutions:

 Deleting cells referred to by other formulas, or pasting moved
cells over cells referred to by other formulas.

 Change the formulas, or restore the cells on the worksheet by
clicking Undo immediately after we delete or paste the cells.

 Using an Object Linking and Embedding (OLE) link to a program
that is not running.

 Start the program.
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 Linking to a Dynamic Data Exchange (DDE) topic such as “system”
that is not available.

 Make sure that we’re using the correct DDE topic.

 Running a macro that enters a function that returns #REF!

•  Correct a #VALUE! Error

This error occurs when the wrong type of argument (argument: The
values that a function uses to perform operations or calculations. The
type of argument a function uses is specific to the function. Common
arguments that are used within functions include numbers, text, cell
references, and names.) or operand (operand: Items on either side of
an operator in a formula. In Excel, operands can be values, cell
references, names, labels, and functions.) is used.

1. Optionally, click the cell that displays the error, click the button
that appears, and then click Show Calculation Steps if it appears.

2. Review the following possible causes and solutions.

 Entering text when the formula requires a number or a logical
value, such as TRUE or FALSE.

 Microsoft Office Excel cannot translate the text into the correct
data type. Make sure that the formula or function is correct for
the required operand or argument, and that the cells that are
referenced by the formula contain valid values. For example, if
cell A5 contains a number and cell A6 contains the text “Not
available”, the formula =A5+A6 will return the error #VALUE!.

 Entering or editing an array formula, and then pressing ENTER.

 Select the cell or range of cells that contains the array
formula (array formula: A formula that performs multiple
calculations on one or more sets of values, and then returns
either a single result or multiple results. Array formulas are
enclosed between braces { } and are entered by pressing
CTRL+SHIFT+ENTER.), press F2 to edit the formula, and then
press CTRL+SHIFT+ENTER.

 Entering a cell reference, a formula, or a function as an array
constant.

 Make sure that the array constant (constant: A value that is not
calculated and, therefore, does not change. For example, the
number 210, and the text “Quarterly Earnings” are constants.
An expression, or a value resulting from an expression, is not a
constant.) is not a cell reference, formula, or function.

 Supplying a range to an operator or a function that requires a
single value, not a range.

 Change the range to a single value.

 Change the range to include either the same row or the same
column that contains the formula.
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SummarySummarySummarySummarySummary

• Setting up a spreadsheet can be fairly time consuming, although templates,
or sample spreadsheets, are available with most of software packages. The
computeried spreadsheet can be formatted with different print layouts. It
allows working with rows and columns of numbers and use formula to do
“what if” calculations. The spreadsheet gives considerable power and
flexibility in entering and editing information, setting up calculations with
formula and functions, and printing the results. It has rows that are
horizontal lines of information that are numbered on the left-hand side of
the Excel workbook. Columns are vertical lines of information and are
identified by letters along the top of the spreadsheet. Rows and columns
intersect to form cells.  A cell is addressed by the column and row position,
for example B4 is the intersection of column b and row 4.

• In the earliest spreadsheets, cells were a simple two-dimensional grid.
Over time, the model has been expanded to include a third dimension, and
in some cases a series of named grids, called sheets.

• In any worksheet or spreadsheet a cell is the smallest element which may
contain a value or a formula or a function or it may simply be left empty. To
use formula or function in the cell; usually begin with = sign by convention.

• A cell reference is the name cell in the spreadsheet. Most cell references
indicate another cell in the same spreadsheet, but a cell reference can also
refer to a cell in a different sheet within the same spreadsheet or to a value
from a remote application. A typical cell reference consists the column
followed by a row number is called relative cell reference. Both column
and row number; either part can be relative changes when the cell or
formula in it is moved or copied from other cell or absolute (indicated with
$ in front of the part concerned of the cell reference). The older “R1C1”
reference style consists of the letter R, the row number, the letter C, and
the column number; relative row or column numbers are indicated by
enclosing the number in square brackets. Most current spreadsheets use
the A1 style, some providing the R1C1 style as a compatibility option. When
the computer calculates a formula in one cell to update the displayed value
of that cell, cell reference(s) in that cell, naming some other cell(s), cause
the computer to fetch the value of the named cell(s).

• A reference to a range of cells is typically of the form (A1:A6) which specifies
all the cells in the range A1 through to A6. A formula such as “=SUM
(A1:A6)” would add all the cells specified and put the result in the cell
containing the formula itself.

• A function is a special key word which can be entered into a cell in order to
perform and process the data which is appended within brackets. There is
a function button on the formula toolbar (fffffx); which function offers assistance
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and useful prompts into a spreadsheet cell. Alternatively we can enter the
function directly into the formula bar. A function involves four main issues:

• Name of the function.

• The purpose of the function.

• The function needs what argument(s) in order to carry its assignment.

• The result of the function.

• Formatting of spreadsheets makes easier to read and understand the
important information (e.g. conditional formatting, number formatting, text
and general spreadsheet formatting etc.). A cell or range can optionally be
defined to specify how the value is displayed. The default display format is
usually set by its initial content if not specifically previously set, so that for
example “24/11/1952” or “24 Nov 1952” would default to the cell format of
“date”. Similarly adding a % sign after a numeric value would tag the cell
as a percentage cell format. The cell contents are not changed by this
format, only the displayed value.

• To print an entire spreadsheet choose Page Setup from the File Menu,
Choose the appropriate options in terms of horizontal (landscape) or vertical
(portrait) printing, Excel prints entire spreadsheet document, if the document
is too wide to fit on a page, Excel will print the remaining columns on
subsequent pages before continuing to print the remaining rows.

• We can save our document every 5 minutes. The first time we  save, go to
the File Menu and pull to Save, make sure the document is in the correct
folder and on the correct drive, type the name for what we want to save it
as, and click in the save box.
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EXERCISE

Q1. MULTIPLE CHOICE QUESTIONS

1. The best way to get started in Excel 2007 is to click the _____. 

a. View toolbar.

b. Home tab.

c. Microsoft Office Button.

d. None of the above.

2. Which key combination collapses the ribbon?

a. [Ctrl]+[F1]

b. [Ctrl]+[F3]

c. [Ctrl]+[F5]

d. [Ctrl]+[F7]

3. Which view shows margins and the rulers?

a. Normal

b. Page Layout

c. Page Setup

d. Review

4. As you type a number in a cell, what mode appears in the status bar?

a. Enter mode

b. Ready mode

c. Edit mode

d. Record mode

5. Where is the address of the active cell displayed?

a. Row heading

b. Status bar

c. Name Box

d. Formula bar

6. Which command reverses the last action performed in the worksheet?

a. Cut

b. Undo
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c. Redo

d. Paste

7. When navigating in a workbook, which command is used to move to the
beginning of the current row?

a. [Ctrl]+[Home]

b. [Page Up]

c. [Home]

d. [Ctrl]+[Backspace]

8. Which key when pressed displays the access keys?

a. [Alt]

b. [Ctrl]

c. [Shift]

d. [Esc]

9. Which command allows you to reverse an Undo command?

a. Redo

b. Repeat

c. Reset

d. Reverse

10. Which function results can be displayed in AutoCalculate?

a. SUM and AVERAGE

b. MAX and LOOK

c. LABEL and AVERAGE

d. MIN and BLANK

11. Which cell alignment is assigned to most values by default?

a. Right

b. Left

c. Centre

d. Decimal

12. Which function automatically totals a column or row of values?

a. TOTAL

b. ADD

c. SUM

d. AVG
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13. Which mathematical operator is represented by an asterisk (*)?

a. Exponentiation

b. Addition

c. Subtraction

d. Multiplication

14. Which step completes an entry and moves the pointer to the cell to the right?

a. Pressing [Enter]

b. Pressing [Tab]

c. Pressing [Shift]+[Tab]

d. Pressing [Shift]+[Enter]

15. How many blank worksheets are shown when a new workbook is created?

a. One

b. Two

c. Three

d. Four

Q2. ANSWER THE FOLLOWINGS QUESTIONS

1. Define spreadsheet and its salient features?

2. Write any five advantages using electronic spreadsheet in place of manual
spreadsheet.

3. Define workbook and worksheet. What is the difference between them?

4. Explain active worksheet?

5. Using Fill: Series command in Excel write down the steps to fill data from
120,320…..2300 in Column A.

6. Define Data Range, Name Range and How these are created and selected?

7. Write down the steps for the use of Custom Lists.

8. Explain the purpose of Format, Conditional Formatting and Auto Format.

9. What is Wrap Text feature of Excel, Merging of Cells and what will be the cell
address of merged cells?

10. Explain the purpose of using Print Preview?

11. Explain difference between relative reference and absolute reference?

12. Discuss IF function and nested IF functions giving example?

13. Write down examples for any two financial functions you know with their proper
syntax.
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14. What is the use of PMT function?

15. How many ways Data Entry is possible in Spread Sheet?

16. Define one-variable Table and Two-variable table. Explain these with examples.

17. Define Pivot Table and explain usage?

18. What are formulas and how they are created?

19. Write down the differences between formula and function?

Q3. SKILL REVIEW

A. You had started your own online business to sale and find out the sales for the
first week is as follows:

Monday Rs.120.45

Tuesday Rs.187.43

Wednesday Rs.106.87

Thursday Rs.143.69

Friday Rs.117.52

Saturday Rs.87.93

Sunday Rs.92.12

Use a function to work out how much you earned, on average, each day.

B. Use a Days360 function to work out how many days are left before your next
birthday. Instead of typing out the current date in say cell A2, you can use this
inbuilt function:

=Now (   )

The Now function doesn’t need anything between the round brackets. Once
you have today’s date, you can enter your birthday in say cell B2.

C. Create an Activity Report (Weekly) for a Sales Representative working in a
reputed home appliances manufacturing company. Details recorded should
contain Date of Visit, Day of Visit, Name of Shop/Dealer Visited, Address, Phone
Number, Name of Product (Dealing), Type of Response (by the Dealer), Demand
of Product and Duration Spent (in hrs)..

a. Fill data in Date of Visit, Day of Visit using Fill Series.

b. Name the worksheet created above as Weekly Visit Report.

c. Cerate Product-wise, Dealer-wise Monthly Report which should include Total
Hours Spent.

d. Count total number of dealers visited and dealers who gave positive
response.
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Create a worksheet to record sales of home appliances sold by M/s Home Maker
Ltd. In the following format:

Date of Name of Name of  Make Quantity Sales
Sales Customers Products      Amount

The product lists includes Television sets, Refrigerators, Micro wave ovens,
Water Coolers, Air Coolers, Geezers and Air conditioners of different Makes
(and models). The cost of price of television is ranging from Rs. 10,000 to
Rs. 56,000; refrigerator is Rs. 13,000 to Rs. 45,000, micro wave ovens, water
coolers, geezers and air coolers are from Rs. 8,000 to Rs. 25,000 and Air
Conditioners are from Rs. 18,000 to Rs. 55,000. The shopkeeper sales these
products adding 17.25% more on cost price. He provides a discount of 4.35%
on total amount if any customer purchases two products on the same date.
Enter 30 records of different dates (for a month) and different customers
accordingly. Calculate the following:

a. Product wise weekly sales and discount.

b. Calculate the profit of shopkeeper.

c. Product wise total sales of the month and discount offered.

D. Create a worksheet to keep track of revenue collected and expenses done in
conducting tour programs at different tourist places during 2004 to 2008.
Format the numeric data in currency format, prepare year wise columns for
revenue and expenses for each tourist place and calculate the difference. The
calculated difference may be negative, the format of negative balance may be
red coloured. Use conditional formatting for higher and lower values of revenue
and expenses. Align entire text in centre. The font of tourist place is Arial with
14 point while the font of year is Times Roman with 14 points.

(Amount in lacs)

Tourist 2004 2005 2006 2007 2008
 Place

Rev Exp Rev Exp Rev Exp Rev Exp Rev Exp

 Manali 123 55 234 123 345 333 333 365 365 453

 Kashmir 234 123 123 55 365 453 345 333 333 365

 Shilong 345 333 333 365 123 55 234 123 456 233

 Kerala 333 365 365 453 234 123 123 55 345 333
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   ANSWERS

1. c 2. a 3. b 4. a 5. c 6. b

7. c 8. a 9. a 10. a 11. b 12. c

13. d 14. b 15. c
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